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Welcome to the latest version of 2014 Knowledge-Based Audits of Common Interest Realty
Associations (5/2/14), the latest title available in the ProSystem /e Knowledge Coach series!

Please review this bulletin prior to installation and use. If you have any questions, call Technical
Support at 1-800-PFX-9998, option 4.

Knowledge-Based Audits of Common Interest Realty Associations is designed to help the practitioner efficiently and
effectively perform financial statement audits of common interest realty associations (CIRAs) in accordance with auditing standards

generally accepted in the United States of America (GAAS).

The Knowledge-Based™ Audit Methodology is a risk-based methodology that emphasizes using knowledge of the CIRA to make risk
assessments in connection with a financial statement audit. This allows the auditor to more appropriately focus audit efforts on
those areas which in the auditor’s judgment are the most significant and pose the most risk to the financial statement audit. The
operations of CIRAs are often unique and complex and require specialized accounting and auditing knowledge. This edition includes
specific up-to-date guidance for auditing CIRAs. Conducting audits of CIRAs requires the exercise of the auditor’s professional
judgment.

This is the third update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the
Knowledge Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2014 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

For more information on the Knowledge-Based Methodology and how it works within ProSystem % Knowledge Coach, refer to the
Additional Information section in this bulletin.

WORKPAPER NOTES

Important Note for Customers updating binders from 2011 or 2012 Knowledge Based Audits of Common Interest Realty Associations

You must install Engagement 7.0 and Knowledge Coach 2.0 March 2014 Update before updating to the 2014 Knowledge Based
Audits of Common Interest Realty Associations. Engagement 7.0 and Knowledge Coach 2.0 March Update atre required to use the
2014 Knowledge-Based Audits of Common Interest Realty Associations. For more information on Engagement 7.0 and Knowledge
Coach 2.0 Update, review the Release Notes and associated Knowledge Base article at the following link:
http://support.cch.com/updates/KnowledgeCoach/.

General Roll Forward Note
You must be the current editor of all Knowledge Coach workpapers to update to the latest content during roll forward, and you
must be the current editor upon opening the updated workpaper for the first time to ensure you see the updated workpaper.

The 2014 Knowledge-Based™ Audits of Common Interest Really Associations has been updated to help auditors conduct audit
engagements in accordance with the new clarified and redrafted auditing standards resulting from the ASB’s Clarity Project and


http://support.cch.com/updates/KnowledgeCoach/

related guidance, including the requirements of SAS-128, Using the Work of Internal Auditors. Many new tips and examples have
been incorporated. The 2014 tools include links to specific guidance that provides instant access to detailed analysis related to the
steps and processes discussed in the workpapers. Also included are revised financial statement disclosures checklists that provide a
centralized resource of the current required and recommended GAAP disclosures and key presentation items, using the style
referencing under the FASB Accounting Standards Codification™.

Specific Program Enhancements

For more information on specific program enhancements, review the 2074 CIRA Title Overview for Knowledge Coach Users guide
available in the binder through the KCO-001 workpaper or at the following link:
http://support.cch.com/productsupport/productsupport.aspx?path=%2FTopics%2Fproduct support%2Fpfx office%2Fknowled
ge coach#Guides

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:

Statements on Auditing Standards (SASs):
SAS-128, Using the Work of Internal Auditors.

FASB Accounting Standards Codification as of March 10, 2014, and through Accounting Standards Update No. 2014-05—Service
Concession Arrangements (Topic 853).


http://support.cch.com/productsupport/productsupport.aspx?path=%2FTopics%2Fproduct_support%2Fpfx_office%2Fknowledge_coach#Guides
http://support.cch.com/productsupport/productsupport.aspx?path=%2FTopics%2Fproduct_support%2Fpfx_office%2Fknowledge_coach#Guides

Additional Information on Knowledge Coach and the KBA Methodology

The key components of the Knowledge-Based™ Audit Methodology include:

e An Overview that guides practitioners through the respective methodology;

e Customizable Audit Programs that take practitioners through related steps and procedures designed for use in audit
engagements;

e Practice Aids to help practitioners complete steps or processes outlined in other related documents;

e Reports that provide a variety of sample auditor’s and accountant’s reports;

e Correspondence documents that provide sample engagement letters and management representation letters to be used in
many common situations; and

¢ Knowledge-Based Audit documents, integral to the overall engagement process, that contain steps and procedures
required by GAAS.

The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards - The audit-related practice aids and tools in the 2014
Knowledge-Based Audits of Common Interest Realty Associations are designed around the AICPA’s risk assessment and
clarified standards to assist auditors of CIRAs by:

e Facilitating compliance with GAAS;

e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;

e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.

ProSystem A® Knowledge Coach

ProSystem A® Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently by
eliminating the need for duplicate entry of the same information, tailoring audit documentation to each particular engagement, and
documenting the link between risks identified and procedures performed. AUD-100 Tailoring Question Workpaper is 2 document in
Knowledge Coach that presents engagement-level questions designed to aid in tailoring the engagement documentation to fit each
client. Completing the questions helps the auditor avoid duplication and unnecessary workpapers.

Before you begin your audit, please review the guidance in AUD-101 Overall Audit Program. This workpaper is intended to be your
road map through a Knowledge-Based Audit methodology. You should start your audit with AUD-100 Tailoring Question Workpaper
and AUD-101 Overall Audit Program.

Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers prompt
the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented
risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper identified in” field of
the Risk pane.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

Diagnostics help keep track of untesolved issues like unanswered questions, incomplete tisks, program steps not linked to risks or
relevant assertions, missing workpaper, and more. Diagnostics now show when a form table has not been answered (i.e. tables in

KBA-101 Overall Audit Strategy that are added by the tailoring questions in AUD-100 Tailoring Question Workpaper).

Links to Accounting Research Manager (ARM)-1f you subscribe to an ARM library that includes audit content, you can link directly to
source material from Resources within Knowledge Coach documents. These links have been updated to reference to the accounting
standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you
subsctibe to the Knowledge-Based Audits of Common Interest Realty Associations Guide on ARM, you can take advantage of brand new links
to the audit guide material from within the Knowledge Coach documents.

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane. Informational
features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and



efficiently. We have also added the ability to navigate from Resources within a document or the tip pane directly to CCH’s
Accounting Research Manager and industry audit guides by simply clicking on the Reference.

Important Notes

e Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

e If your Current Editor Knowledge Coach MS Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open, then highlight the workpaper in the binder window and go to

Tools>Save Knowledge Coach Answers.

o Review http://support.cch.com/answerdoc.aspx?id=sw33722 for more information.

e Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central
file room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements

e 'This title MUST be used with ProSystem fx Engagement version 7.0 and higher. The 2013 Financial Statement Audit Base
is also required.

e Ifyouare upgrading from ProSystem /x Engagement 6.0, 6.1, 6.1.2, 6.5, 6.8, or 6.11 please contact Technical Support at 1-
800-PFX-9998, option 4 for detailed instructions.

® A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx
Knowledge Coach documents.

Download Instructions

Download the 2074 Knowledge-Based Audits of Common Interest Realty Associations from the ProSystem fx Knowledge Coach Updates
section of the ProSystem /x Engagement Support Web site at the following URL:
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series and Download file link next to the
2014 Knowledge-Based Audits of Common Interest Realty Association. On some occasions the content package file (KCP)
has downloaded with the extension changed to .ZIP. If this occurs, please change the extension of the downloaded file to KCP
using all capital letters.

Important: ProSystem fx Engagement version 7.0 or higher must be installed on the computer in order to install this Knowledge
Coach title. Additional requirements include Microsoft Oftice 2007, Microsoft Office 2003 Primary Interop Assemblies (PIA) and
Visual Studios 2005 Tools for Office Second Edition Runtime (VSTOR).

The following 2014 Knowledge-Based Audits of Common Interest Realty Associations (4/30/14). KCP download is a proptietary
file that must be installed from within Engagement. Save this KCP file to a location on your local drive, extract it, and follow the
Installation Instructions included in the Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx
Engagement. The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach program
content files. Please refer to the ProSystem fx Engagement with Knowledge Coach Release Notes for any other system
requirements.


http://support.cch.com/answerdoc.aspx?id=sw33722
http://support.cch.com/updates/KnowledgeCoach

After downloading the 2074 Knowledge-Based Audits of Common Interest Realty Associations titles, do the following:

1. Launch the ProSystem fx Engagement Workpaper Management application so that the Local File Room is
displayed. Select Tools > Knowledge Coach Titles.
The Knowledge Coach Titles window will be displayed.

2. Choose Add Title.

3. Browse to the title package file (*.KCP) that you previously downloaded and extracted from the ProSystem fx
Knowledge Coach Support Web site.

4.  Choose Open.
The system will display a progress indicator while the title package is added. You will receive a message that the
title has been successfully installed once the process is complete.

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “untelease”
previous versions of the title.

To unrelease a title:

1. Select a version of the KBA CIRA Audit title.
2. Choose Untrelease Title. The date will be removed from the Date released column and staff that do not have the
staff group property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.

Note: You can determine this access in the ProSystem fx Engagement Admin module by selecting a staff group and
choosing File > Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:

1. Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
2. Choose Release Title. The current date and time will be displayed in the Date released column, and the status will
change to “Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Tools title license in the
ProSystem fx Engagement Administrator before using the workpapers.

Important: Once the 2074 Knowledge-Based Audits of Commeon Interest Realty Associations titles have been added and released,
they will be automatically deployed to other staff members when they login to the “Office” location, or when they
synchronize a binder that contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at http://tax.cchgroup.com or when adding or updating the new
licenses within ProSystem fx Engagement with Knowledge Coach version 7.0 and higher. After updating the license file in the
ProSystem fx Engagement Admin module, licenses need to be assigned to the staff who will use 2014 Knowledge-Based Aundits of
Common Interest Realty Associations.

If you have not already established a Single Sign-on (SSO) account with Customer Setrvice, we urge you to do so at this time.

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
http://tax.cchgroup.com/pfxsupport, clicking the Firm Administration link, and making the appropriate selection (SSO access is
required), or by contacting Customer Service at 1-800-PFX-9998, option 4.



http://tax.cchgroup.com/
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Accounting Research Manager

CCH’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus
guidance from financial reporting experts.

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you’ll learn of newly released literature and
deliberations of cutrent financial reporting projects as soon as they occut! Plus, you’ll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.

Also available is the Knowledge-Based Audits of Common Interest Realty Associations, a guide that helps you comply with the most
recent professional standards and guidance for the conduct of audits of common interest realty assocations and to integrate the use
of practice aids, tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based
documents that are available in Knowledge Coach.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more

about our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com.

You can also access the Accounting Research Manager Web site by selecting the item in ProSystem fx Engagement from the
Guidance tab on the Shortcuts bar in the Binder window.

Links to Accounting Research Manager (ARM)

As indicated above, subscribers to an Accounting Research Manager library that includes source content can link directly to source
material from references within Knowledge Coach workpapers. These links have been updated to reference the new Codification
released by the FASB and available on ARM. The Codification on ARM is fully integrated with U.S. and international accounting
standards, other non-authoritative materials and industry leading interpretive guidance.

Using Your Knowledge Coach Content

Go To use your Knowledge Coach Workpaper Templates, opena  New knowledge Coach Workpaper %
binder in ProSystem fx Engagement, select the workpaper tab into
which you would like to insert the workpaper, and select New
Knowledge Coach Workpaper from the toolbar or File menu.
The New Knowledge Coach Workpaper dialog appears (Figure 7).

Select the New Knowledge Coach Title with the content you
would like to use. You can only select titles you have installed.
The information displayed changes to reflect the workpaper
organization available for the selected title. Select the
Knowledge Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper Properties
dialog appears. Each workpaper name is automatically loaded
into the Name field. Add a workpaper index in the Index field
and make any Name modifications you desire. You can also
modify the tab location or the roll forward settings for each
workpaper. Then click OK. The integrated Knowledge Coach
workpaper is now inserted into your engagement binder. For ok | [ camcsl | [ reb
more information on how to use Knowledge Coach
workpapers in your binder, see the Knowledge Coach User

Industry- [2014 KBA CIRA Audits 5/16/2014 -]

D Show independent workpapers only

000-Resources Details of selected workpaper
100-The Communications Hub

200-Pre-Engagement Procedures

300-Risk As ment-U g the CIRA & Environment
400-Risk Assessment-Design of Internal Controls
500-Assessing Risk of Material Misstatement

600-Audit Procedures-Response to Assessed Risks Highlight a workpaper or select a
700-Audit Procedures-Tests of Internal Contrals workpaper check box to see details
800-Audit Procedures-Substantive Tests
900-Evaluating. Concluding & Reporting Procedures

Figure 1 - New Knowledge Coach Workpaper


http://www.accountingresearchmanager.com/

Guide.

Download 2014 Knowledge-Based Audits of Common Interest
Desctription: Realty Associations (4/30/14)

Version: Engagement v. 7.0 with Knowledge Coach or higher
Release Date: April 2014

File size: 18MB

%Iig ;OX' Download 42 minutes at 56 kbps

License: Full Version

Platforms: Windows XP/Windows 7/Windows 8/Vista

Office: Microsoft Office 2007 required

Contact Information

For a demo or to purchase additional titles as they become available 1-800-PFX-9998, option 1
Technical Support 1-800-PFX-9998, option 4, then option 1

The ProSystem fx Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by
CCH, a Wolters Kluwer business. The contact information above can be used for customer service and support issues for this
product. For information about other CCH products, please call 1-800-248-3248 or visit the online Store at

http:/ /tax.cchgroup.com.
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